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VEHICLE EXHAUST GAS ANALYSER (VEGA) FAULT FINDING
Leak test Fail/ Lambda Failure
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Gas Analyser not communicating
• Check mains supply OK and the analyser module is switched on
• Check communication cable
• Check platform Config for conflicts

LHC Residue Test Failure
• Check sample probe in free air, blow out sample probe & pipe assembly if required
• Change gas filters if heavily contaminated and wash filter bowls with warm soapy water

Low Gas Flow
Ensure that the filters have been removed and cleaned or replaced, sample probe has been
checked for damage and blockages.

High Lambda Readings
The system is drawing in air, please ensure the following – All filter bowls are undamaged and
sealed (hand tight and a little bit, do not over tighten or you will damage the o ring). Sample
probe and pipe are undamaged and connections are tight.

Remove Probe from Exhaust message (at beginning of an MOT test)
Check the O2 sensor two pin connector is still connected and the millivolt reading is no less than 7
millivolts.
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Hash Error/reset/ Audit Log Invalid

If the machine is coming up with an error relating to the wrong hash then to fix this issue you will
need to clear the old hash code to do this:-

Get the customer to go into to service mode > Serial Number Update > enter the Serial at the top
of the screen into the entry box.

• On the Gas programme, select Service Mode on the right hand side
• Ask for the displayed calibration request code
• Give the customer the reply code
• After this, customer should have lots more options down the right side
• Select "Service Mode Diagnostics"
• Then "Gas Analyser Serial Number Update"
• Ensure that the serial number matches the one on the unit - customer MUST re-enter

serial no. Then, click on "Audit Log Diagnostics" (right hand side)
• Will come up with a load of "gobble-dee-gook"
• Just click Exit/Blue Arrow/X - back to the main screen

F0 00 00 00 (aka IR Bench)
This error could mean that the gas has moisture inside. The weather plays a part in this failure as
this can be caused by condensation on cold mornings. It can also be caused by water not being
emptied from the water trap each day.

On a 680EN1

To fix the issue:-

• Disconnect the 3 pipes from the small bowls (2 small at the top and 1 Large at the
bottom)

• Run Leak test for 2 hours with a heater (nothing more than an internal building
radiator) next to the device.

• Switch the device off using the red rocker switch at the back at the bottom
• Switch the device back on

If this fails to resolve the issue then an exchange gas for warranty or a fixed price repair are the
only options.
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High HC (Hydrocarbons)
Go to live readings and check HC, the reading should be less than 20 parts per million (PPM)

If no improvement, then remove right hand filter bowl. Check readings, if improved then clean
bowls, replace filters.

Remove probe see if it eventually drops to below 20. If it does, clean probe/hose, if that doesn't
help then replace hose/probe.

Oxygen Cell Failure
To check the Oxygen cell

Go into the Tools menu and select “Oxygen Cell Diagnostics” then run test.

The results should be between 5 and 13 if it’s anything else then the oxygen cell to be replaced.

If the customer has a replacement on site then they will need to replace the cell and then run
Install new Oxygen cell under: - Tools > Oxygen cell diagnostics> Install new Oxygen cell.

https://www.cryptontechnology.com/images/support/pdf/how-to-guides/o2-cell-expired.pdf

680 Wrong Date

If the unit is showing the wrong date this can be changed by

Petrol Menu > Tools and Setup > Service Mode > Engineer code > Set Time and Date

Changed the time and date accordingly, click continue and then exit back to the main menu

Do a live reading print out to make sure the date has been changed.

NB: Do not confuse this with calibration date being incorrect.
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VTS printing
We have identified a small program error on a small number of Windows 10 machines running the
682 gas analyser. The issue can be identified by a lack of VTS information on the gas print out.
Should you experience this fault there is a simple solution as detailed below.

• Using WGTS3, enter the VTS details in the usual way.

• Close WGTS3.

• Launch Regedit (to do this type regedit after pressing the start button)

• Locate the below folder
[HKEY_CURRENT_USER\Software\Crypton\vts]

• Now highlight the vts folder and export the key (go to File > Export)

• Save the reg file to the desktop, call it VTS.reg

• Edit VTS.reg with a text editor (such as notepad) and change the key path in the file to:

• [HKEY_CURRENT_USER\Software\Crypton\WGTS3\vts]

Save the file, and then close it.

Double-click the reg file and accept the elevated prompt, then click "Yes" to the continue
message.

When this is complete then re-launch WGTS3 - the VTS details should appear on the printout.
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Log File error
1) On the Gas program, select Service Mode on the right hand side

2) Get the calibration code off them

3) Give them the reply code

4) After this, customer should have lots more options down the right side

5) Select "Service Mode Diagnostics"

6) Then "Gas Analyser Serial Number Update"

7) Ensure that the serial number matches the one on the unit - customer MUST re-enter serial no.

Then, click on "Audit Log Diagnostics" (right hand side)

9) Will come up with a load of "gobble-dee-gook"

10) Just click Exit/Blue Arrow/X - back to the main screen

Smart Card Server
For systems that exhibit a ‘SmartCard Server’ issue in the UK Petrol test after the Diesel update has
been applied, they can be recovered with the following procedure.

In Control Panel, select WGTS3UK, then select Repair.

The following Windows Installer box will be displayed.

Type in the following path into the box
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Then Click Ok.

This will restore the missing file.

If the Platform Configuration Utility has been run whilst the file is missing then use the Platform
Configuration Utility again to configure the Smartcard to an unused serial port.
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DIESEL SMOKE METER (DSM) FAULT FINDING
Battery Charging
The DX260-1BT wireless Smoke head contains a Multi-Cell Rechargeable Battery designed to give
a maximum of 1.5 hours endurance from a full charge.
The smoke head must always be replaced on the charging cradle in between tests.
It is also strongly recommended that the batteries be completely discharged on a monthly basis
by setting the program to Live Readings with the smoke head off the charger.
Please note that rechargeable batteries have a finite lifespan, therefore the battery pack will need
to be replaced periodically if the smoke head is no longer sustaining sufficient charge for correct
operation.

LED Indica�on
Smoke head removed from charging cradle:

• LED ‘On’ continuously:
Smoke head is running on internal battery

• LED pulsing ‘ON’ for 2 seconds, ‘OFF’ for 0.5 seconds:
Smoke head battery has reached a Low Voltage condition, and has less than 10 minutes
life left before auto-shutdown.

• LED ‘OFF’:
Low Voltage condition. Smoke head will auto shut down. No more testing possible until
smoke head battery has been recharged.

If the smoke head has received no communication from host computer for over 6 minutes it will
go into ‘Sleep’ mode. Return the smoke head to the charging unit to invoke a response.

If the smoke head is taken outside its maximum operating range of about 100 metres, and wireless
communication is no longer possible, after 6 minutes the smoke head will go into ‘Sleep’ mode.

To recover from ‘Sleep’ mode, the smoke head should be put back in its charging cradle, and the
LED function observed.

Smoke head returned to Charging Cradle:
• FAST CHARGE (2.5 flashes per second):

The Smoke head is in ‘Fast Charge’ Mode. The battery should fully charge within 1.5 hours

• TOP-UP CHARGE (1 flash per second):
The Fast Charge cycle has completed and the battery is being brought to full charge

• SLOW CHARGE (1 flash every 2 seconds):
The Smoke head battery is in ‘Slow Charge’ mode, the charging rate determined by either
terminal voltage or, battery cell temperature
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Battery Charging cont.
• TRICKLE CHARGE (1 flash every 3 seconds):

LED Flashing ON/OFF shows the smoke head battery is in ‘Trickle-Charge’ mode
indicating that the batteries are fully charged.

Fault Diagnosis:
• FAST FLICKER (8 flashes per second or more):

The smoke head has detected poor charging contacts. Clean the contacts on both the cradle and
the smoke head feet and replace on charger

• LED NOT ILLUMINATED:

Return the Smoke head to Charging Cradle. LED should display according to Charging level
required.

• LED NOT ILLUMINATED WHEN SMOKEHEAD IS ON CHARGING CRADLE:
• Check that the smoke head is correctly seated on the charging cradle. The smoke head

has twin connectors on each insulated foot, and may be connected either way round
• Check the charging cradle is connected to the 240V AC mains
• Check that the sprung connectors that transmit the charging current on the charging

Cradle are clean and not stuck in a depressed condition.
• Check that the charging connectors on the insulated mounts on underside of the smoke

head are clean and free of dirt and obstructions.

To check the charging voltage at the charging cradle:

• Connect a digital multi-meter set to measure up to 30V DC to the two charging
• Connectors on the charging cradle and depress the central charging switch
• A voltage of 28V to 30V DC should register on the multi-meter display
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Bluetooth Smoke Head charging contacts

Bluetooth Smoke Head equipment can experience charging issues due to faulty or corroded
charging contacts. This problem can be caused by several factors which need to be looked at
individually, but there are three main areas of corrective procedure:

• Charger base microswitch height adjustment
• Charger base contact replacement
• Smoke Head contact replacement

Ensure equipment is isolated from the mains supply before commencing work on the charger
assembly. Ensure the battery pack output terminals can NOT be ‘shorted’ together at anytime
during the Smoke Head contact replacement procedure.

Adjustment of the Microswitch
Charger base microswitch height adjustment should be set so that the microswitch is heard to
operate when the Smoke Head rubber foot is between 1-2mm from the charging base. If the
microswitch is set to operate at a too high a setting then arcing of the charging contacts will
occur. If it is set too low then it may fail to activate.

Charger base contacts
Replacement may be required if the contacts have become severely corroded. Corrosion will
occur if arcing has been taking place due to incorrect microswitch adjustment or can be a result of
the contacts becoming dirty from contaminants and debris picked up from the workshop floor.
Restricted movement of the contacts may also occur as a result of dirt or excessive heat from
arcing.

Smoke Head charger contacts
Replacement may be required if the contacts have become severely corroded

Good The contact has slight wear, but otherwise acceptable.

Poor The contact is slightly corroded through contact with
dirt etc. Also, small signs of pitting of the plating.

Bad The contact shown left is showing bad signs of arcing
and corrosion and should be replaced.
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Battery Replacement

Removal:-

• Unscrew the knurled knob (1) and open up both end caps.
• Remove the four pan head screws (2) & (3) securing both end plates and carefully ease

the plates clear of the housing
• At the fan end, disconnect the 2-pin battery plug (4a) and the 2-pin fan plug (4b)
• At the probe end, disconnect the 3-pin plug (5)
• Depending on which version you have either - loosen the two screws (6a) or remove the

plastic spacer (6b) securing the battery pack
• Discard the two securing screws or the plastic spacer– they are no longer required

Note the orientation and remove the battery pack. Do not remove by pulling the cables, and
ensure the connectors do not foul any components during removal of the board.

Move the activation link from the transit position Fig. 1 to the live position Fig. 2.

Fig. 1 - Activation link - Transit position Fig. 2 – Activation link – Live position
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Lens Cleaning
Two lenses are fitted in the smoke head, one at either end. The smoke meter checks the
cleanliness of the lenses at the start of each test, and the PC will provide a warning when cleaning
is required.

Accessing a lens
• If fitted, remove the sampling pipe
• Unscrew the knurled knob at the sampling pipe end of the sampling head and remove the

end cap.
• Carefully pull out the lens housing and wipe the lens with a soft cloth (if required, a little

methylated spirit will assist cleaning)
• Refit the lens housing with the arrow pointing upwards (a little silicon grease on the 'O'

ring will assist fitment – but do not get on lens!)
• Refit the end cap and tighten the knurled knob

NOTE: Ensure the end cap locates fully against the body of the sampling head before tightening
the knob. If not correctly located, the lens housing is probably not fully home.
1. Clean the lens at the other end of the smoke head in the same way.

NOTE: The end cap for the sampling pipe must be fitted at the end away from the sampling head
cable.
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Cable Renewal

Should the cable become damaged and require renewal, the procedure is as follows:
• Unscrew the knurled knob (1) and remove the end cap
• Remove the four countersunk screws (2) which secure the internal fan and grille to the

smoke head end plate
• Remove the four pan head screws (3) securing the end plate and carefully ease the plate

clear of the housing
• Disconnect the 4-pin multi-plug (4a). If carrying out a fan replacement disconnect the 2-

pin plug (4b) and replace the fan. Carefully fit the fan and fan grille to the end plate (4
countersunk screws)

• Remove the 4 wires from the 4-way plug. Undo the metal cable clamp from the end plate.
Loosen the cable gland strain relief and remove the cable from the end plate

• Re-fit the new cable through the cable gland strain relief and secure to the end plate with
the metal clamp (Important: secure the clamp on the earth braid of the cable). Re-fit the
4-way plug. Ensure the cable gland strain relief is tightened

• Connect the 4-pin multi-plug (4a) and the 2-pin plug (4b)
• Locate the end plate to the smoke head (cable on left hand side) and loosely secure with

the four pan head screws
• Check that the lens housing is fully in, then fit the end cap and secure with the knurled

knob. Fully tighten the knurled knob then slacken half a turn
• Push the end plate upwards as far as it will go, and then fully tighten the 4 pan head

screws.
• Fully tighten the knurled knob on the end cap
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Adjusting oil temperature probe length

Before testing, the probe must be adjusted to the correct length as follows:
Lay it alongside the vehicle dipstick (see illustration) and adjust the position of the depth stop until
the effective length of the probe is approximately 10mm shorter than the dipstick.

WARNING: ENSURE THAT THE OIL TEMPERATURE PROBE IS SET TO THE CORRECT DIPSTICK
LENGTH AND THAT IT IS CLEAN FROM DEBRIS BEFORE INSERTING INTO THE ENGINE. FAILURE
TO DO SO MAY RESULT IN SERIOUS DAMAGE TO THE PROBE AND/OR ENGINE.
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Smokehead Power Supply Test
Use a Digital Volt Meter (DVM) to measure the voltage output from the Smokehead Charging
Cradle.

Bluetooth Enabled Units
The output from a Bluetooth Unit cradle should be 30VDC±0.2V (Smokehead present button
depressed). If the reading is outside of these limits gain access to the power supply inside of the
trolley assembly and adjust the output voltage using the adjustment potentiometer on the side of
the power supply unit. Ensure the polarity is such that the +ve output pin is closest to the trolley
i.e. right hand pin when viewed from the front of the assembly.

Cabled Units
Remove the Smokehead end cap and unplug the cable inside the head before switching
power on. Connect the DVM to the red and black leads & switch power on – the output
should be 24VDC±0.2V. If the reading is outside of these limits gain access to the power
supply inside of the trolley assembly and adjust the output voltage using the adjustment
potentiometer on the side of the power supply unit.
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Smoke Head Fan replacement

The Smoke Head fan can require changing due to damage to the vanes or excessive
soot build up which can cause the bearings to fail.

Procedure
• Unscrew the knurled knob (1) above and remove the end cap.
• Remove the four countersunk screws which secure the internal fan and

grille to the smokehead end plate. Discard the screws.
• Remove the four pinhead screws Fig.1 (2) securing the end plate and carefully

ease the plate clear of the housing.
• If you are working on a DX.260-1 cabled smokehead, carefully disconnect the

4 pin communications cable from the Printed Circuit Board (PCB) see Fig. 2 for location

• Carefully disconnect the 2-pin fan plug from the PCB see Fig.3 for location.
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• Clean fan grille and filter using warm soapy water. Thoroughly dry both parts.
• Re connect the 2-pin plug from the fan to the main PCB. (Red wire nearest the

fan end of the smokehead)
• If required re connect the 4 pin communications cable connector to the main PCB

(Black wire nearest the fan end of the smokehead).
• Fit the new fan, old fan grille and filter to the end plate using screws and hole

plugs supplied in kit AS09867 and in the order/positions shown in Fig 4. Do not
over tighten the screws in the fan plastic housing.

• Locate the end plate to the smokehead (cable or Bluetooth blanking plug on left
hand side) and loosely secure with the four pinhead screws.

• Check that the lens housing is fully in (arrow pointing upwards) see Fig.5, then
refit the end cap and secure with the knurled knob. Fully tighten the knurled
knob the slacken half a turn Fig.1 (4)
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• Push the end plate upwards as far as it will go, and then fully tighten the 4
pinhead screws Fig.1 (5)

• Fully tighten the knurled knob on the end cap.

Emissions Tester CCP700/800 Series Hints & Tips

25

Optics failure

If the lenses are not reading correctly on the DX 260 then it would be worth checking/cleaning the
lenses for the smoke meter, to clean the Lenses:-

Take panel on the ends off > pull out the LED holder > check the Lens of the LED is clean > isn’t
RED inside (otherwise the seal at the back has leaked)> replace LED holder back into device > put
panel back on > retest

Cleaning the Lenses
Two lenses are fitted in the smokehead, one at either end.

The Smokemeter checks the cleanliness of the lenses at the start of each test, and the PC will
provide a warning when cleaning is required.

Accessing a Lens

The cleaning procedure is as follows.

• If fitted, remove the sampling probe.
• Unscrew the knurled knob at the sampling probe end of the sampling head and remove

the end cap.
• Carefully pull out the lens housing and wipe the lens with a soft cloth (if required, a little

methylated spirit will assist cleaning).
• Refit the lens housing with the arrow pointing upwards (a little silicon grease on the 'O'

ring will assist fitment – but do not get on the lens!).
• Refit the end cap and tighten the knurled knob.
• NOTE: Ensure the end cap locates fully against the body of the sampling head before

tightening the knob. If not correctly located, the lens housing is probably not fully home.
• Clean the lens at the other end of the smokehead in the same way.
• NOTE: The end cap for the sampling probe must be fitted at the end away from the

sampling head cable.

Blip test Fail (Microphone failure)

If the microphone fails then this needs to be exchanged as there is nothing the customer can do
to replace the damaged microphone (usually due to excessive heat damage).
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Battery failure
The battery should be charging at around 24V if it is anything lower then it will not power
correctly and will need to change. To check the meter reading for the battery:-

Remove Panel end > unplug the green pin plug >

The battery charger should be charging At 30V to check this

Missing Bluetooth Code

Move the mouse cursor to the bottom right to bring the start task bar up

On the taskbar, find the BT icon (may need to click on show hidden icons first (the arrow pointing
up ).

Right click it and select "Add a device"

System should scan for any BT devices in the area (if finding oil temp ensure it is out of holster).
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Find and select the device you require the ID for

Right click it and select "Properties"

On the next screen select "Bluetooth" Tab at the top

Near the bottom there will be "Unique Identifier", this is the BlueTooth ID for the device.

Note this down and enter into the platform config as required.
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BLUETOOTH SYNC

Smoke Head
https://www.cryptontechnology.com/images/support/pdf/how-to-guides/bluetooth-smoke-
meter-setup.pdf

Temp Device
https://www.cryptontechnology.com/images/support/pdf/how-to-guides/bluetooth-
communication-setup-guide-oil-temp.pdf

Tach Device
https://www.cryptontechnology.com/images/support/pdf/how-to-guides/bluetooth-
communication-setup-guide-battery-tach.pdf
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PRINTER ISSUES

Printer Sleep Timer Delay
https://www.cryptontechnology.com/images/support/pdf/how-to-guides/printer-sleep-mode.pdf

Printer Guide Inc. LED Indicators
https://www.cryptontechnology.com/images/support/pdf/how-to-
guides/Printer_Includes_LED_Indicators_Crypton.pdf

Brother Printer Toner
If subsequent to a replacement toner cartridge being fitted it appears not to have worked try the
following reset process.

• Open the front cover and leave open while completing the following steps.
• Turn the printer off.
• Hold the ‘go’ button while turning the printer on. All panel lights should be on.
• Release the ‘go’ button.
• Press the ‘go’ button 2 times.
• Pause.
• Press the ‘go’ button 5 times.
• The toner light should be off.
• The paper light should be on or flashing.
• Close cover.
• The ready light should be the only light on
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